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I. Formats  
 

• .IFC → The .ifc format is a recommended format that can be converted by 
NEXT-BIM. 
 

• Navisworks : To use the Navisworks plugin, the .NWD and .NWF formats are 
supported by NEXT-BIM Configurator. If you want to read another format 
supported by Navisworks, you need to convert your file to the .NWF format. 
You can find a list of supported formats here: 
https://help.autodesk.com/view/NAV/2023/ENU/?guid=GUID-1DD9E13D-
7FEC-4936-B45E-C59E4A3E96EC. 

 

• .nbim →  The .nbim format is the NEXT-BIM format used by the NEXT-BIM 
Explorer module. It allows you to visualize your projects in NEXT-BIM 
Explorer. NBIM files should be placed in the "document" folder of your 
Hololens 2. 

•  

 

• .nbim_project → The .nbim_project format is used to save your project on your 
PC, including the corresponding configuration, using relative paths. This 
means that all the necessary files for the project, along with the associated 
configuration, are saved locally on your computer with relative file paths. This 
helps to maintain the project's links and structure, even if you move or transfer 
the project to another location. 

 

• .nbim_preconfig → The .nbim_preconfig format allows you to save 
configurations created during a project for later reuse. It saves configurations 
for all tools (annotations, materials, properties, etc.). Additionally, all 
configurations such as annotations, checklists, visibility lists, tabletop mode, 
etc., can be saved separately. In the desired configuration menu (for example: 
Configuration > Annotation), click on "File" > "Import/Export NEXT-BIM" and 
select the corresponding configuration file (annotation/checklist, tabletop, 
etc.). (See photo below) 
 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/
https://help.autodesk.com/view/NAV/2023/ENU/?guid=GUID-1DD9E13D-7FEC-4936-B45E-C59E4A3E96EC
https://help.autodesk.com/view/NAV/2023/ENU/?guid=GUID-1DD9E13D-7FEC-4936-B45E-C59E4A3E96EC


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 
 

 

A. Discover the functionalities 
To open a file in NEXT-BIM Configurator, follow these steps: 

1. Go to the top menu “File” 
 

2. Select the "Add File" option 

 
To import .IFC files into NEXT-BIM Configurator, you can either select the desired 
.IFC files or import a compressed .IFCzip file. 

Similarly, for .NWD or .NWC files, you can use the same method. Select the .NWD or 
.NWC files you want to import into the project. 
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When you open a file for the first time, the software performs triangulation on the 
file. It's important to wait for the triangulation process to complete before using the 
software's features. Triangulation is the process of converting the model into a 
format suitable for display and manipulation within the software. 

During subsequent openings of the same file, the software imports the file from the 
cache area. In this case, triangulation is not performed as the file is already 
converted. This reduces the loading time, allowing quicker access to the software's 
features. 

If you import files in .NWD or .NWC format, a "Navisworks" window will 
automatically open when the file is opened. This window allows you to select 
specific sub-files you want to import into NEXT-BIM Configurator from the source 
file. 
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B. Rename your files  
 
To rename your files in NEXT-BIM Configurator, follow these steps : 

1. Access the "Hierarchy" window in the software. 
2.  Right-click on the file you want to rename. 

 

 
3. A dialog box will appear, allowing you to modify the file name. Enter the new 

name based on the appropriate technical discipline. 
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By renaming your files according to the technical disciplines, you facilitate their us-
age in NEXT-BIM Explorer and avoid overly long names, making file management 
more convenient and intuitive. 

 

C. Open an existing project  
  

 
To open an existing project in NEXT-BIM Configurator, follow these steps : 

1. Click on the "File" menu in the top menu bar of the application. 

2. From the dropdown menu, select "Open project." 

3. A file explorer window will open. 

4. Navigate to the location where the project file is saved. 

5. Select the project file you want to open. 

6. Click the "Open" button in the file explorer window. 

7. The selected project will then be opened in NEXT-BIM Configurator, and you 
can work on it with all the available functionalities. 

 

Make sure to locate and select the correct project file you want to open in the file 
explorer to ensure the project is opened correctly. 
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D. Import/export a configuration (.nbim_config) 
 
To save the configuration in NEXT-BIM Configurator, follow these steps: 

1. Click on the "File" menu in the top menu bar of the application. 
2. From the dropdown menu, select "Import/export configuration file." 
3. In the submenu, choose "Export full configuration file." 
4. A file explorer window will open, allowing you to choose the location to 

save the configuration file. 
5. Select a location on your PC where you want to save the configuration 

file. 
6. Give an appropriate name to the configuration file and click the "Save" 

button. 

By following these steps, you can export and save the full configuration file in NEXT-
BIM Configurator for future use. 

 
To import a previously saved configuration into a project in NEXT-BIM Configurator, 
follow these steps: 

1. Click on the "File" menu in the top menu bar of the application. 

2. From the dropdown menu, select "Import/export configuration file." 

3. In the submenu, choose "Import full configuration file." 

4. A file explorer window will open. 

5. Navigate to the location where you previously saved the exported 
configuration file. 

6. Select the desired configuration file from your documents. 

7. Click the "Open" button to import the configuration into the current project. 

8. Ensure that you select the correct configuration file during import/export to 
avoid any confusion. 
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By following these steps, you can import a previously saved configuration file into 
your project in NEXT-BIM Configurator, allowing you to reuse configurations and 
streamline your workflow. 

 

E. Generate a .NBIM File, the NEXT-BIM Explorer 
format (generate .nbim) 

 
To generate the .nbim file for Hololens in NEXT-BIM Configurator, follow these 
steps: 

1. Click on the "File" menu in the top menu bar of the application. 
2. From the dropdown menu, select "Generate NBIM." 
3. A file explorer window will open, allowing you to choose the location to save 

the .nbim file. 
4. Navigate to the desired location in your file explorer. 
5. Give an appropriate name to the .nbim file. 
6. Click the "Save" button to save the .nbim file to the specified location. 
7. The generated .nbim file can then be transferred and used on your Hololens. 

Make sure to save the .nbim file in a location accessible from your Hololens so 
that you can load and use it within your Hololens application. 

By following these steps, you can generate the .nbim file for use with Hololens in 
NEXT-BIM Configurator, enabling you to view and interact with your projects in the 
Hololens environment. 

 

 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 

 
 

 
II. 3D View 
1. Preview (Display 3D view) 

 

In the menu bar, a drop-down menu lets you control what you see in the 
3D view.

 
 

• Preview all: all files are displayed, similar to the .NBIM file. 
 

• Preview tabletop: previews the display in tabletop mode 
 

 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 
• Preview selection: displays only objects in the selection list 

 
• Preview checklist: displays only objects in the checklist 

 
 

• Preview visibility list: preview a visibility list 

2. Camera control  
 

• Rotate: left-click + move mouse 

 

• Shift point of view: right-click + move mouse 

 

• Zoom: mouse wheel 

 

• In Orbit mode, the camera rotates around the point of view; in Fly mode, the 
camera turns on itself. 

 

3. Center view 
Center view to return to initial view. 
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4. Quick view display (top, bottom, side view) 

Click on the camera icon to quickly display a specific view.  
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 :   3D view from above 

 :   3D left side view 

 :   3D right side view 

 :  3D view from below 

 

 

III. Selection  
The selection list allows you to perform actions on several objects at the same time.  

To add or remove objects from the selection list, several options are available: 
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• In the Hierarchy window or 3D View, right-click on an object to display the 
context menu. 

• In 3D View, hold down the CTRL key and left-click on the objects you wish to 
select. 

• Use the search function to find specific objects. In the top menu, "Edit" > 
"Find". 

To configure the selection in NEXT-BIM Configurator, follow these steps: 

1. Access the selection window: 
• At the bottom left of the software, click on the link indicating the number of 

objects in the selection. For example, "X objects in selection". 
• Alternatively, you can access the selection window using the top menu. Click 

on "Windows" then select "Selection". 
 

2. Use the actions available for selection : 
• Once the selection list contains objects, you'll see various actions available in 

the selection window. 
• Possible actions include : 

 

o Remove all selected objects from .nbim file generation. > "Removed 
object from output  

o Add or remove objects from the selection list: 
o Convert your selection into a checklist using the "Create new checklist 

with default state" option. 
o Color selected objects using the "Add new material to objects" option. 
o Create a visibility list corresponding to your selection using the "Create 

new visibility list with selection" option. 
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➢ "Remove all selected objects from output":  deletes objects when .nbim is 
generated 

 

➢ “Create new checklist with default state": allows you to convert your selection 
into a checklist  

 

➢ “Add new material to objects: color selected objects  

 

➢ “Create new visibility list with selection": creates a visibility list corresponding 
to your active selection. 
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A.  Selecting an object from the model 
To select an object from the model in NEXT-BIM Explorer, follow these steps: 

 

1. Right-click on the object in the model: Locate the object you wish to select in 
the 3D model and right-click on it. 

2. Add object to selection: In the pop-up menu that appears, select the "Add 
object to selection" option. This will add the object to your selection list. 

3. Display selected objects : Objects you have selected will be automatically 
highlighted to make them easier to distinguish in the model. They will be 
visually highlighted. 

4. Customize highlight color: In the "Selection" panel, you can change the 
highlight color of selected objects. To do this, click on the corresponding color 
box and select the desired color. You can also uncheck the "Highlight 
selection" box to completely deactivate the highlight color on selected objects. 
However, it is recommended to leave this feature active to facilitate viewing of 
selected objects. 

By following these steps, you can select individual objects from the model in NEXT-
BIM Configurator and customize the way they are highlighted for greater visual 
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distinction.

 
  

 

The selected object is added to your selection   
 
 

Selected objects are automatically highlighted.  

In the "Selection" panel, change the highlight color by clicking on the color box, or 
uncheck the "Higlight selection" box to deactivate the highlight color on selected 
objects (we recommend you leave this feature active). 
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B. Multiple selection 
 

To perform multiple object selection in NEXT-BIM Configurator, follow these steps:: 

Option 1 : 

1. Hold down the "Ctrl" key: Before starting your multiple selection, hold down 
the "Ctrl" key on your keyboard. This will enable you to select several objects 
simultaneously. 

2. Left-click on objects: While holding down the "Ctrl" key, left-click on the 
objects you wish to select. You can click on each object individually to add 
them to your selection. 
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Option 2 : 

1. Selection area: If you wish to select several objects at once, hold down the left 
mouse button and drag the mouse to create a selection area. All objects 
within this area will be selected at the same time. 
 

To create a selection with a selection box, hold down the "Ctrl" key and left-click to 
define the top left corner of the selection box, then drag to define the bottom right 
corner of the selection box. All objects inside this box will be selected. 
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All selected objects are now highlighted and displayed in my selection at the 
bottom left of the screen (756 objects in selection). 

Option 3 

Use the "Edit > Find" tool to perform a search and add the results to the selection. 

NEXT-BIM Configurator features a powerful search tool that lets you search for 
objects in the model according to various criteria such as name, properties, levels, 
etc. You can also add the search results to your current selection. You can also add 
search results to your current selection. Here's how it works: 

1. In the top menu of NEXT-BIM Configurator, click on "Edit". 

2. In the drop-down menu, select the "Find" option. A search window will open. 
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3. In the search window, you can specify search criteria, such as object name, 
specific property, level, etc. Enter the appropriate search information in the 
corresponding fields. 

4. Click on the "Search" button to launch the search. Objects matching the 
search criteria will be displayed in the search results window. 

5. To add the objects from the search to your selection, click on "Append" or 
"Replace" if you already have objects in the selection and no longer wish to have 
them in your selection.  

6. The objects searched for will be added to your current selection. 

This lets you use the "Edit > Find" tool to perform a specific search in the model and 
add the corresponding objects to your selection. It's a handy way of broadening your 
selection according to certain search criteria.d'élargir votre sélection en fonction de 
certains critères de recherche. 
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.  

Result of our selection view: All objects with "Door" in their name. 

To display the result of your selection, please follow these steps: 

1. Perform a search using the term "Door" in the search bar. 

2. Select all objects containing "Door" in their name using the "append" 
button. 

3. In the 3D view, you should now see only those objects that match your 
search, i.e. all objects containing "Door" in their name. 

4. Make sure you're in "Preview selection" mode. 
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Display selected objects: Once you have completed your selection, all selected 
objects will be highlighted in the 3D model. They will also be listed in the selection 
window at the bottom left of the screen, where you can see the number of objects 
selected.  

Following these steps, you can make multiple object selections in NEXT-BIM 
Configurator by holding down the "Ctrl" key and left-clicking on individual objects, or 
by making a selection area to select several objects at once. 

 

C. Display your selection 
To view your selection in NEXT-BIM Configurator's 3D view, use the "Preview 
selection" option available in the software. Here's how to proceed: 

1. In the top menu, click on the "Preview All" drop-down menu
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2. Then click on the "Preview selection" button. This will activate the preview 
selection feature. 

3. Once Preview Selection is activated, all the objects you have selected will be 
highlighted in the 3D view of the model. This allows you to see them clearly 
in relation to other objects not included in the selection. 
 

The "Preview selection" option is useful for checking and confirming the objects you 
have selected, by highlighting them in the 3D view. This makes it easier to check 
your selection and ensure that the right objects are included. 

 

 
Preview selection   

 
 

View of the selection ;  
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IV. Inspecting  
A. Inspect an objet 

 
To inspect an object in NEXT-BIM Configurator, you have several options: 

1. Click on the object in the 3D view: By left-clicking on an object in the 3D view, 
it will be highlighted in blue. At the same time, the hierarchy will scroll down 
to this object, highlighting its position in the overall file structure. This allows 
you to visualize its position in the object hierarchy. 

2. Double-click on object in hierarchy: If you prefer to use the hierarchy to 
inspect an object, you can double-click on the desired object in the hierarchy. 
This will have the effect of centering the object in the 3D view, putting it at 
the center of the view. This allows you to examine it more closely and work 
with it more easily. 

 

The object will then be highlighted in blue in the 3D view and the hierarchy will scroll 
down to this object, highlighting its location in the overall file structure. This allows 
you to visualize its position in the object hierarchy. 
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To center an object in the 3D view using the hierarchy, simply double-click on the 
desired object in the hierarchy. This will refocus the 3D view on that object, bringing 
it into the center of the view. This allows you to examine the object more closely and 
work with it more easily. 

B. Inspecting object properties (properties) 
To view the properties of an inspected object in NEXT-BIM Configurator, follow 
these steps: 

1. In the application's top menu bar, click on "Windows". 
2. In the drop-down menu that appears, select "Properties". 
3. A "Properties" window will open, displaying the properties of the object 

currently being inspected. 
4. When you click on an object in the 3D view and it is highlighted in blue, its 

properties will be displayed in the "Properties" window. 

You can browse the various properties of the object, such as its name, dimensions, 
materials, etc.  

This feature allows you to inspect and view the detailed properties of the objects in 
your project, giving you additional information and a better understanding of each 
object's characteristics. It also provides you with the property information you need 
to sort your objects when creating filters by property. 
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V. Contextual Menu 
 

 

To access the contextual menu of an object in NEXT-BIM Configurator, you can right-

click on the object, whether it is in the 3D view or in the hierarchy. By doing this, a 

contextual menu will appear with a list of options and specific functionalities for that 

object. 

Here are the available options in the contextual menu: 

 

• Copy: This option allows you to copy the name, GUID, or IFC type of an object 
("Copy to clipboard"). 

• Apply Color + Texture: If you want to apply a specific material to the selected 
object, you can use this option to access a list of materials and choose the one 
you want to apply ("Add material"). 

• Hide/Show Object: This option allows you to hide or show the object in the 
3D view. This can be useful for simplifying the visualization or focusing on 
specific parts of the model ("Hide object"). 

• Remove Object from .NBIM File: If you want to remove the object from the 
model, this option allows you to do so ("Remove object from output"). 

• Add/Remove IFC Class from Tabletop Mode: This option allows you to add or 
remove the IFC type from the Tabletop mode ("Tabletop: Remove IFC class 
from tabletop"). 

• Add Object to Selection: This option allows you to add an object to your 
selection ("Selection: add object"). 
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• Add Immersion Point on this Object: This option allows you to place an 
immersion point on the object ("Add immersion point here"). 

By using the contextual menu in NEXT-BIM Configurator, you can perform 
various actions and access specific functionalities related to the selected object, 
enhancing your workflow and interaction with the model. 

. 

 

VI. Hierarchy - File tree structure 
Open files appear in your hierarchy.  

Click on the file to open its hierarchy.  

In NEXT-BIM Configurator, the "Hierarchy" window displays your project's file tree. 
You can follow these steps to use the hierarchy: 

1. From the top menu, open the "Windows" > "Hierarchy" window in NEXT-BIM 
Configurator. This window is usually displayed automatically in a panel on the 
side of the user interface. 

2. The various files open in your project will be listed in the hierarchy. These may 
include .IFC, .NWD, .NWC files. 

3. To view the hierarchy of a specific file, click on the file name in the hierarchy 
list. 

4. The hierarchy will then expand to display the elements and components of 
the selected file. You can see the structure and organization of objects in the 
model. 

5. By clicking on individual elements in the hierarchy, you can select or inspect 
them in the corresponding 3D view. 

The "Hierarchy" window lets you easily navigate through files and visualize the 
structure of your project. It is useful for understanding the relationship between 
objects and for performing specific operations on individual elements. 
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To close ALL drop-down lists, click on "Collapse All". 
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A. Hide / Show a file 
To show or hide a file, floor or object in NEXT-BIM Configurator, follow these 
instructions: 

1. In the "Hierarchy" window, locate the file, floor or object you wish to show or 
hide. 
 

2. To the right of the file, floor or object name, you'll see an eye icon. 
 

3. To hide a file, click on the eye icon corresponding to that file. This will make 
the file invisible in the 3D view, but it will remain present in the hierarchy and 
therefore in the .NBIM file (HoloLens) 
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4. To display the hidden file again, click on the eye icon again. The file will 
reappear in the 3D view. 

 

It is possible to hide an object directly from the 3D view by following these steps: 

1. In 3D view, right-click on the object you wish to hide. 
2. In the context menu that appears, find and click on the "Hide Object" button. 
3. The selected object will now be hidden and will no longer be visible in the 3D 

view. 

To find hidden objects and make them visible again, follow these additional steps: 

1. In the application's top menu bar, click on "Windows" (Windows). 
2. Select "Hidden Objects" from the drop-down menu. 
3. A new window will open, displaying a list of hidden objects in your project. 
4. You can click on hidden objects in this window to make them visible again in 

the 3D view. 

This allows you to easily manage hidden objects and find them again when you need 
them. 

 

ATTENTION: There's a difference between "Hide objects" and "Remove objects", 
see here 
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The eye icon is crossed out when the file is hidden.        

 

 
 

To redisplay the file/storey/object, click on the crossed-out eye icon   

 

B. Hide / Show all files 
This feature is useful if you have a large number of files and wish to view just one or 
two of them. Hide all files, then click on the file(s) you wish to view. 

To hide all files in NEXT-BIM Configurator, follow these steps: 

1. In the "Hierarchy" window, find the option entitled "Hide All files". 
2. This option can usually be found at the top or bottom of the list of files in the 

hierarchy. 
3. Click on the "Hide All files" option to hide all files in the hierarchy. 
4. Once you have hidden all files, you will no longer see their representation in 

the 3D view. 

To display the hidden files again, you can proceed in one of two ways: 
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Option 1: 

1. In the "Hierarchy" window, click again on the "Show All files" option. 

Option 2: 

1. In the "Hierarchy" window, you can also click on each file individually to 
display them one by one. 

2. Click on the eye icon next to each file to make them visible in the 3D view. 

This option lets you temporarily hide all files and redisplay them as required, allowing 
you to concentrate on one or more specific files. 

 

Hierarchy > “Hide All files” ( Hide all files ) 
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Hierarchy > “Show all files” -  Display all files
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C. Hide / Show an object 
 

To hide an object directly from the 3D view, follow the steps below: 

1. In 3D view, right-click on the object you wish to hide. 
2. In the context menu that appears, find and click on the "Hide Object" button. 
3. The selected object will now be hidden and will no longer be visible in the 3D 

view. 

To find hidden objects and make them visible again, follow these additional steps: 

- Option 1  

 

1. In the "Hierarchy" window, locate the hidden object. 
2. Next to the object, you'll see a crossed-out eye icon. Click on this icon to make 

it visible again in the 3D view. 

 

- Option 2 

 

1. In the application's top menu bar, click on "Windows". 
2. Select "Hidden Objects" from the drop-down menu. 
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3. A new window will open, displaying a list of hidden objects in your project. 
4. You can click on the hidden objects in this window to make them visible again 

in the 3D view. 

 

To view objects in the file, click on the file arrow in the hierarchy and click on the 
floor in which the object is located. 

Right-click on the object in the hierarchy, then click on to hide it.   

 

 

 

 
 

The object is hidden 
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To redisplay the object, click on the eye icon at the end of the object line.   

 

OR 

 

Windows>Hidden Object>
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Click on the eye icon of the object 

 
The object is re-displayed.

 
 

 

D. Hierarchy context menu 
1. Centering the camera on an object 

Center the camera on a selected object in the hierarchy by following these steps: 

1. In the "Hierarchy" window, locate the object you wish to center the camera 
on. 

2. Right-click on the object in the hierarchy. 
3. In the context menu that appears, find and click on the "Center camera on 

object" option. 
4. The camera will automatically move to center on the selected object. 
5. You can then view the object centrally in the 3D view, making it easier to 

inspect and manipulate. 
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This feature is useful for focusing on a specific object in the 3D view, automatically 
adjusting the camera position to highlight it. 

 

To center the camera on the selected object: Right-click on the object in the 
hierarchy > "Center camera on object".
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2.  Removing an object from the .nbim file using the 
hierarchy   

 

 

 
Removing a specific object from your (.nbim) file by following these steps: 

1. In the "Hierarchy" window, locate the object you want to delete. 
2. Right-click on the object in the hierarchy. 
3. From the contextual menu that appears, find and click on the option 

"Remove object from output." 
4. The selected object will now be removed from the (.nbim) file and will no 

longer be included in the final output. 

This allows you to remove specific objects from the file, customizing the content of 
your project according to your needs. Please note that once the .NBIM file is 
generated, the object will not be available for viewing in NEXT-BIM Explorer. 

To reimport a previously deleted object in NEXT-BIM Configurator, you can follow 
these steps: 

1. In the top menu bar of the application, click on "Configuration." 
2. From the dropdown menu that appears, select "Removed Objects." 
3. A window will open, displaying a list of previously deleted objects. 
4. Browse the list and locate the object you want to reimport. 
5. Then, in the "Removed Objects" window, find and click on the "Re add" 

button to restore the object in your project. 
6. The object will be reintegrated into the hierarchy and reappear in the 3D 

view. 

This allows you to restore previously deleted objects and include them again in your 
project, providing greater flexibility in managing your content. 

Example of deletion: 
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Once the object is crossed out in the hierarchy, it will not be loaded into the format 
.nbim. 
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To see all the items that will not be loaded and also modify this list, see here. 

 
Other functions are available in an object's context menu:

 
• Add in selection = Add this object to your selection  
• Table top : Remove " X " Type from output = Remove the Type (ifcclass) from 

reduced model mode  
• Material : Add new material to object = Only color this object 
• Material : Add new material to ifc(type) = Color all objects of a Type.  
• Checklist : Add object to checklist = Available if a checklist has already been 

created. Adds the object to your checklist. 
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• Visibility list = Available if a visibility list has already been created. Adds the 
object to an existing visibility list. 

 

VII. Hidden objects 
 

To find all the objects you have hidden in NEXT-BIM Configurator, follow these 
steps: 

1. In the application's top menu bar, click on "Windows". 
2. In the drop-down menu that appears, select "Hidden Objects". 
3. A "Hidden Objects" window will open, displaying a list of all the objects you 

have hidden. 
4. In this window, you can browse the list of hidden objects. 
5. To redisplay a specific object, click on the "Un-hide" icon corresponding to 

that object in the list. 
6. The object will then be made visible again in the 3D view. 
7. If you wish to redisplay all hidden objects simultaneously, you can click on the 

"Un-hide all" button. 

This allows you to easily manage and redisplay hidden objects in your project, giving 
you greater control over their visibility in the 3D view. 

 

Example:  

Find all the objects you've hidden. 

Windows menu > Hidden Objects
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A list of all the objects you have hidden will appear.  To redisplay an object, click on 
the "  " icon. 

To redisplay all objects, click on Un-Hide all. » 

 
 

VIII. Filters 
Filters in NEXT-BIM Configurator enable you to sort and apply specific 
configurations to your objects, such as checklists, materials, tabletop configurations 
and so on. They also help you to add targets for the target-based rapid realignment 
tool, or to make the continuous registration system more reliable. 

Here are a few tips for creating effective filters: 

1. Think generically: When creating filters, take the time to design them 
generically, so that they can be reused in future projects. The more precise 
and generic your filters, the faster and easier it will be to apply configurations. 

2. Use properties: Sorting by properties is useful for achieving high accuracy if 
you use the same properties on all your projects. You can filter objects 
according to their specific properties. 

3. Consider naming conventions: If you have similar naming conventions from 
one project to another, sorting by name can be an interesting option. You can 
filter objects by name. 

4. Use .ifc type: Although sorting by .ifc type is efficient, it doesn't provide the 
same level of detail as sorting by property or name. However, it can be used 
to filter objects according to their .ifc type. 
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Tip for model cross-sections: You can create filters containing model areas to avoid 
having to generate multiple projects (nbim_project). This allows you to work on 
specific sections of your layout without having to create new projects. 

It's important to note that using per-file rules in the checklist tool requires you to add 
a rule for each IFC type, and to select the IFC types present in the file. If the .IFC 
types are not selected, the objects in the file will be considered as a group of objects, 
resulting in an incorrect number of objects in your checklist. 

By using filters effectively, you can apply specific configurations to your objects and 
improve your workflow in NEXT-BIM Configurator. 

 

 
Menu Windows > Filters  
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NEXT-BIM Configurator offers two filter libraries: the Project filter library on the left 
and the Shared filter library on the right. 

 
When you save a filter in the Project filter library, it will be specific to that project 
only. This means that the filter will not be available when you open a new project. 
This is useful if you have filters specific to a particular project and you don't want to 
apply them to other projects. 

On the other hand, when you save a filter in the Shared filter library, it will be 
accessible in all your projects. This allows you to save generic, reusable filters that 
you can apply to different projects. When you open a new project, these filters will 
be available and applicable, making it easier to manage and reuse configurations. 

So it's important to choose the right library for your needs. If you want to save a filter 
for a specific project, use the project library. If you want to save a filter for general 
use in all your projects, use the shared library. 

This enables you to manage your filters efficiently and apply them according to the 
specific requirements of each project, or share them between several projects to 
optimize your workflow. 

Use the "+" button to create a filter in the desired library.

 
When creating a filter, rename it (e.g. Door level 1). 
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You can create multiple rules and rule sets in NEXT-BIM Configurator to define more 
complex filters. Rule sets can be nested within each other, offering great flexibility in 
the definition of filter criteria. 

To add a sorting rule, you can use the "Add new rule" button in the filter 
configuration window. This allows you to define filter criteria based on object 
properties. 

When adding a rule, you can specify logical conditions, such as AND and OR, to 
combine multiple criteria. You can also use nesting to create more complex and 
precise filters. 

We recommend that you create a sample template containing elements representing 
the categories you wish to use in your filter. By experimenting with these examples, 
you can create filters using the appropriate rules and apply them to views until you 
achieve the desired result. 

Take the time to think about the filter criteria and use the logical conditions 
appropriately to achieve the desired results. You can create as many rules and 
rulesets as you need to meet your specific filtering requirements 
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A. Rule-based filtering 
Name rule: This rule lets you sort objects by name. You can specify an exact match or 
use wildcards. 

• Type rule: This rule lets you select one or more specific .ifc classes. You can 
filter objects according to their type, such as "Wall", "Window", "Door", etc. 

• File rule: This rule lets you select objects according to the file to which they 
belong. You can specify the file name or use wildcards to represent a set of 
files. 

• Storey rule: This rule lets you select objects according to the floor of the 
building to which they belong. 

• Object property rule: This rule lets you sort objects according to their 
properties. You can specify the property group name, the property name and 
the desired value to filter objects accordingly. 

• Height rule: This rule lets you select objects that are above or below a certain 
altitude. You can specify a lower and/or higher altitude value to filter objects 
within a given range. 

• Object list rule: adds the created selection to the list.  
 

B. Selection-based filtering 
You can also create filters based on a selection of objects. The rule used for this is 
the Object list rule. Here's how to use this rule: 

1. Select the objects you wish to include in your filter using the selection tools 
available in the 3D view or the "Edit" > "Find" search tool. 

2. Once you've made your selection, go to the filters menu and create a new 
filter by clicking on the "Add new filter" button. 

3. In the object list ruler, you'll see an option to add the selection you've created. 
Click on this option to include the selected objects in your filter. 

4. Give your filter a name and define any other parameters you wish to apply to 
the filter, such as the configurations (Checklists, materials, Tabletop) to be 
applied. 

5. Save your filter. 

It is important to note that when creating a filter from a selection, this filter will be 
specific to the current project and cannot be reapplied to another project. If you wish 
to use the same filter in different projects, you will need to recreate the filter by 
making the corresponding selection in each project. 
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Make sure you take this limitation into account when creating selection-based filters, 
and choose the filtering method that best suits your specific needs. 

C. Invert the rule 
You can invert a rule by clicking on the rule name. This selects the opposite of what 
is specified in the rule. For example, if you have a "Name contains" rule, you can click 
on it to invert it to "Name does not contain". 

Here's how to reverse a rule: 

1. Go to the filter where you have defined the rule you wish to reverse. 
2. Locate the rule you wish to reverse, for example the "Name contains" rule. 
3. Click on the name of the rule, in this example "Name contains". 
4. Clicking on the rule name will invert the rule to "Name does not contain". 
5. Be sure to check that the rule inversion corresponds to the filtering condition 

you wish to apply. 
6. Save your changes to the filter. 

By inverting a rule, you can select objects that do not match certain specified criteria. 
This offers greater flexibility in the creation of your filters and allows you to select 
precisely the objects you wish to include or exclude. 

Each rule can be inverted to select the opposite of what is specified: 
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D. Condition AND only 
 

When a ruleset uses the AND condition, all its rules and nested rulesets must be 
true. 

 
 

1. EXAMPLE « AND » condition filter  
The "AND" condition allows you to combine rules to be more precise in your 
searches. The use of "AND" means that all the rules applied must be true.  

1. To create an "AND" condition filter, follow these steps : 
2. Go to the filters menu and create a new filter. 
3. Add the necessary rules using the rule types mentioned: "Type rule", 

"Storey rule" and "Object property rule". 
4. Type rule: Select the "ifc door" class to filter objects that are doors. 
5. Storey rule: Select the "First floor" level to filter objects located on this 

floor. 
6. Object property rule: Configure the rule to filter objects with a specific 

property. In this example, you would specify the "width" property with a 
value of "0.915". 

7. Check that all rules are configured with the correct conditions. 
8. Once your filter is complete, press "Back" to return to the filter list. 
9. To preview the filter, click on the "Preview filter" icon (eye icon). 
10. The total number of objects filtered according to your filter conditions will 

be displayed at the end of the line. 

This will allow you to create a precise "AND" condition filter to select all doors on the 
second floor with a width of 0.915m. You can apply this filter to your views to view 
only those objects matching these criteria. 
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 Example: 

 
 

 
Press "Back" when your filter is complete 
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Preview your filter by clicking on the eye icon    = "Preview filter"  

 

 
The total number of objects in the filter is displayed at the end of the line 
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E. Condition OR only 

 
The OR condition is used when you want one of the rules or nested rulesets to be 
true for the overall ruleset to be considered true. 

If you wish to select multiple values for the same parameter, you can add a separate 
rule for each desired value. Then, you can nest these individual rules under a ruleset 
with the OR condition. This means that if at least one of the rules for the individual 
values is true, the overall ruleset will be considered true. 

For example, suppose you want to select all objects with a height of 2 meters or 3 
meters. You can add two separate rules, one for the 2-meter height and one for the 
3-meter height. Then, you can nest these rules under a set of rules with the OR 
condition. So, if an object has a height of 2 meters or a height of 3 meters, it will be 
selected by the filter. 

This approach allows you to specify multiple values for the same parameter and 
create more flexible filter conditions using the OR condition. 

 

A. Rule groups with AND/OR conditions 
Using rule groups with AND and OR conditions requires careful planning to achieve 
the desired results. 

In some cases, you'll need to use the AND condition with nested OR conditions. This 
means that all OR conditions within the rule set must be satisfied for the overall rule 
set to be considered true. 

In other cases, you'll need to use the OR condition with nested AND conditions. This 
means that at least one of the AND conditions within the ruleset must be satisfied 
for the global ruleset to be considered true. 

Proper use of AND and OR conditions with nested rulesets allows you to create 
more complex and precise filters to meet your specific needs. It's important to 
understand the expected results and plan accordingly to achieve the desired results. 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 
B. Create a nested filter (contains different objects) 

Use the "Rule group" rule to include different types of objects in a filter. 

 
Windows menu > Filters > Add new rule > Rule group  
Example:  

1. We want to add the windows on level 1 in addition to the doors on 
level 1, 0.915m.  

 
2. We transform our previous filter (0.915m level 1 door) into a nested 

filter (rule group).  
3. Apply a general "OR" rule.  

 
4. Now we want to add the level 1 windows. Add a nested rule group. 

 
5. Add rules for level 1 windows inside the rule group. 

• Use a rule type (class ifc) to select the windows. 
• Add a storey rule to select level 1. 

 
Warning: when creating a filter with a type-based rule (class ifc), it is 
important to ensure that the ifc class contains only the objects you wish to 
include in the filter. If the ifc class contains other object types that should not 
be included, you will need to use additional rules such as rules based on 
properties, names, etc., to refine the selection of objects to be included in the 
filter. 
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Result : 
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C. Others example   
Here's an example of using nested rule sets with AND and OR conditions: 

Suppose you want to filter the elements of your BIM model according to the 
following criteria: 

1. Select all Level 1 walls (Storey rule: Level 1). 
2. Select all "Window" elements with a height greater than 2 meters (Type rule: 

Window, Property rule: Height > 2m). 

To do this, you can create a filter with the following nested rule sets: 

1. Rule set 1 (AND condition) : 
 

• Rule 1: Storey rule: Level 1 (selects walls on level 1). 
• Rule 2: Rule group (OR condition): 

o Subrule 1: Type rule: Window (selects windows). 
o Sub-rule 2: Property rule: Height > 2m (selects elements with a height 

greater than 2 meters). 

In this example, rule set 1 must satisfy both rule 1 (selection of walls on level 1) and 
rule set 2 (selection of windows with a height greater than 2 meters). 

Using this configuration, you can obtain a filter that accurately selects walls on level 
1 and windows with a height greater than 2 meters. 

This example illustrates how nested rulesets with AND and OR conditions can be 
used to create complex, precise filters based on different selection criteria. 
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IX. Settings 
A.  General 

1. Change background color 
To change the background color in the settings, follow these steps: 

 

1. Click on the "settings" button in the top menu 
2. In the settings window, find the "General" section  
3. Look for the "Background Color" option  
4. Click on the color box or button to open the color palette. 
5. Select the desired color by clicking on it in the color palette. 
6. Once selected, the color is immediately applied to the application 

background. 

 
 

 

2. Set your unit of measurement 
To change the unit of measurement in the parameters, follow these steps: 

1. Click on the "settings" button in the top menu 
2. In the settings window, find the "General" section  
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3. Look for the "Units" option  
4. Set the desired unit of measurement, Meters = Metric, Inches = Imperial 

 

 
 

 

 

3. Default configuration 
Allows you to set the current configuration as the default configuration when 

NEXT-BIM Configurator is opened. 

 

B. Cache 
When an .ifc file is loaded for the first time, it is converted to an .nbim_preprocessed 
file and placed in a cache folder. The next time the same .ifc is opened, the 
.nbim_preprocessed file is reused, rather than having to be converted again. 

The location of the cache and its maximum size can be configured in the Settings >  

Cache menu. 

 

 We advise you not to go below the default maximum size of 

    default maximum size of 8 GB for ease of use. 
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To manage the cache area in the application settings, follow these steps : 

 

1. Access the application settings by clicking on the top menu. 

2. Find and select the "Settings" option. 

3. In the settings window, look for the "Cache" section or a similar option. 

4. Click on the "Cache" option to access the cache zone settings. 

5. You should see options for configuring cache location and maximum size. 

6. To change the cache location, click on the corresponding option and select 

the desired folder. 

7. To change the maximum cache size, you can usually adjust a slider or enter 

a specific value. 

 

 
 

 

 
 

1. Clear your cache 
To clear the cache, Cache> "Clear entire cache". 
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2. Increase cache storage capacity 
To increase the size of your cache zone, Cache > Drag the "Maximum cache size" 
bar. 

"Maximum cache size 

 
 

 

Note that the cache zone is automatically updated if the weight of the cache 
zone exceeds the defined weight ("Maximum cache size"). The cache is 

updated from the oldest file to the most recent. 
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3. Change destination of .nbim_preprocessed files 
To change the location of .nbim_preoprocessed files on your computer, Cache > 
Change Location 

 
 

C. Navisworks Plugin 
 

1. How to install the Navisworks plugin ? 
 

To install the Navisworks plugin and integrate it with NEXT-BIM Configurator, follow 
these steps: 

1. Download the Navisworks plugin package from the following GitHub 
page: https://github.com/NEXT-BIM/next-bim-
releases/releases/tag/v2023.1.0. 

2. Make sure you have already installed NEXT-BIM Configurator, at least 
version 2023.1.0. 

3. Go to the NEXT-BIM Configurator installation folder on your system. 
4. In the Configurator folder, find the folder "deps "[Version]\NBIM.Export". 

Copy this folder. 
5. Go to the Navisworks Manage installation folder on your system. By 

default, it is located in "C:\Program FilesAutodesk\Navisworks Manage 
[Version]". 

6. Paste the "NBIM.Export" folder you copied earlier into the Navisworks 
Manage "Plugins" folder. Make sure the .dll file is located as follows: 
"C:\Program Files\Autodesk\Navisworks Manage 
[Version]\Plugins\NBIM.Export\NBIM.Export.dll". 
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Be sure to replace "[Version]" with the specific version of Navisworks you're using. 
For example, if you're using Navisworks Manage 2023, the full installation path 
would be "C:\Program Files\Autodesk\Navisworks Manage 
2023\Plugins\NBIM.Export\NBIM.Export.dll". 

 

7. In the Configurator, access the "Settings" menu, go to the "Navisworks" 
tab and select the corresponding Navisworks version. This will enable the 
Configurator to work in harmony with Navisworks. 
 

 
 

Once these steps have been completed, you can open Navisworks files from the 
Configurator using the "File/Add .ifc" option. You can select .nwd/.nwc/.nwf files and 
open them directly in the Configurator. 

This will enable you to use NEXT-BIM Configurator functions with your Navisworks 
files. 
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2. Navisworks Process 
 
The process for using Navisworks with NEXT-BIM Configurator is as follows: 

1. In Navisworks, ensure that your project contains all the objects you want to 
visualize in NEXT-BIM Configurator. 

2. Create discipline-specific batch files to organize your objects. For example, 
create separate files for architecture, structure, electrical, plumbing, etc. It is 
recommended to include keywords in the object names to facilitate sorting 
and the application of specific configurations. 

3. If your project is in a format other than .NWD, .NWC, or .NWF, you need to 
convert it to .NWF format. Use the conversion function in Navisworks to 
perform this operation. 

4. Certain objects may have an impact on HoloLens performance. If these 
objects are not necessary for your use case, it is recommended to hide or 
delete them. Here is a list of objects that are not recommended: grid with 
small openings, unnecessary facade, detailed CAD parts/machines, 
screws/fasteners. Hiding or deleting these objects in Navisworks will reduce 
the complexity of the model for optimal use in NEXT-BIM Configurator. You 
can use the context menu of the selection tree in Navisworks to hide objects 
or files. 
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5. If your Navisworks model is too heavy or if you need a specific section for 
your use case, you can use the cutting function in Navisworks. Here are the 
steps to follow: 

• Select "Viewpoint" in the Navisworks menu bar, then choose "Enable 
Sectioning." 

• Select the "Box Section" mode. 
• Perform the cut on your model by defining the cutting box. 
• Save the cut in a separate file by clicking on the Navisworks icon at the 

top left of the interface, then selecting "Save As." Save the file in .NWF 
format. 

6. Once you have prepared your Navisworks model following these steps, you 
can import it into NEXT-BIM Configurator for optimal visualization and collab-
oration. 

 

 

3. Cutting your Navisworks model 
To cut your model in Navisworks and save the cut as a separate file in NWF format, 
follow these steps: 

1. Import your model into Navisworks. 
2. Access the "Viewpoint" menu in the Navisworks menu bar. 
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3. Select "Enable cut" from the drop-down menu. 
4. Select the "Box cut" mode from the cut options. 
5. Use mouse manipulation to define the cut box around the part of the 

model you wish to keep. 
6. Once the cut has been made, click on the Navisworks icon in the top left-

hand corner of the interface. 
7. Select "Save as" from the drop-down menu. 
8. Save the file in NWF format, giving it a distinct name to indicate that it is 

the cut version of the model. 

By following these steps, you can create a specific cut of your Navisworks model and 
save it as a separate NWF file. This cut can be used for more targeted visualization 
or to meet specific use cases in NEXT-BIM Configurator. 

• Import file into Navisworks 

 
 

• Go to "Viewpoint" > "Activate cut". 
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• Select box cut mode.   
 

 
• Cut the model 
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• Save your cut as a separate file.  Click on the Navisworks icon at top left and 

click on "save as" > save file in NWF format.. 
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4. How do I convert my project to .NWF format? 
 

To convert your Navisworks project to .NWF format, follow these steps: 

1. Open your model in Navisworks. 
2. Configure your view according to your needs, by hiding files or objects, or 

using trim boxes to delimit the desired area. 
 
 

3. Once you've configured your view as you wish, you can export it in .NWF 
format. 

4. In Navisworks, click on the Navisworks icon at the top left of the interface. 
5. In the drop-down menu, select "Export" or "Export". 
6. Choose the "Navisworks NWF (*.nwf)" export format. 
7. Select the destination location where you wish to save the .NWF file. 
8. Click on the "Export" or "OK" button to start the export process. 

Navisworks will convert your project to .NWF format, preserving the view 
parameters you have configured. Once the export is complete, you'll have a .NWF 
file ready to use in NEXT-BIM Configurator for your viewing and configuration needs. 
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5. Open my Navisworks files (NWD, NWC, NWF) 
 

To open a Navisworks file in NEXT-BIM Configurator, follow these steps: 

1. Open NEXT-BIM Configurator.  

2. Open the file in Navisworks  

3. Go to "Additional tools". 

 
 

4. Click on "Export to NEXT-BIM Configurator", and your file will be imported 
into NEXT-BIM Configurator.In NEXT-BIM Configurator's "File" menu, select "Add 
file".
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•  If your file contains sub-files or linked files, you can select them from 
the "Hierarchy" window in NEXT-BIM Configurator  

• Once you have selected the desired files, click on "Import" to import 
them into NEXT-BIM Configurator. 

As a reminder, NEXT-BIM supports .NWD and .NWF file formats for direct import. If 
you have another file format supported by Navisworks (see the list of formats here: 
https://help.autodesk.com/view/NAV/2023/ENU/?guid=GUID-1DD9E13D-7FEC-
4936-B45E-C59E4A3E96EC), you will need to convert it to .NWF format before you 
can import it into NEXT-BIM Configurator. 

 

 

 

X. “Edit” > “Find” : Search function 
A. Perform a search (Edit>Find) 

To perform a search in NEXT-BIM Configurator, follow these steps: 

 

1) From the "Edit" menu, select "Find" or use the corresponding keyboard 
shortcut. 

 

2) In the search window that opens, you can specify the search criteria for the 
objects you wish to find. 

 

3) For example, you can search by name, type (ifc class), storey (floor), .ifc file or 
object properties. 

 

4) Enter the appropriate search criteria in the corresponding fields.  
 
You can search for full or partial names using keywords. 

 

5) Click on "Find" to launch the search. 
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B. Creating a selection of objects using the "Find" tool 
: 

 

To create a selection of objects using the "Find" tool:  

 

• After performing a search with the "Find" tool, matching objects will be 
displayed in the search result window. 

 

• You can see the number of objects found and the details of the search. 

 

 

• To add the objects found to your selection, click on "Append". If a selection is 
already active, you can choose to replace it by clicking on "Replace". 

 

• Once you've added the objects to your selection, the "Selection" window will 
automatically open, highlighting the selected objects. 

 

 

• You can also change the highlighting color by clicking on "Highlight selection" 
and choosing a different color. 

 

• If you wish to perform another search, you can click on the "+" button to open 
a new search window and specify new criteria. 

This enables you to search for and select specific objects according to your search 
criteria in NEXT-BIM Configurator. 

 
C. Example : 

Go to the top menu: "Edit" > "Find" 
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1. Filter searches by name 
You can search for objects by their full or partial name, i.e. if the object is called 
"M_Upper Cabinet - Single Door - Wall", searching for "Door" in "Name" will bring 
up all objects with "Door" in their name. 
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67 objects with the word "Door" were found. To find the "M_Upper Cabinet - Single 
Door - Wall" doors, repeat the search by name with "M_upper", for example, by 
clicking on "update result".  

 
 

To add them to our selection, click on>Append. If a selection is already active, click on 
"Replace" to replace the selection with your latest search.  
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Once added, the "Selection" window opens automatically. 

Selected objects are highlighted. You can remove the selection color 

by clicking on "Highlight selection".  

To perform a second search, return to the Edit>Find tab and click on the 

the "+" button. 
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2. Filter searches by properties 
 

Example :  

To apply rules to search for objects by properties, Edit>Find and click on the "Add 
rule" button. 
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Three property filters are available: by set name, by name and by value. 

(name), by value (value) 
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Enter the corresponding Property: Set name / Name / Value to search for objects. 

 

It is important to note that if you create a filter from a selection of objects in NEXT-
BIM Configurator, this specific configuration will not be automatically reapplied to 
another project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

XI. Configuration  
 

A.  Configure annotations : Preparing your annotation 
list 

Annotation editing is available in the headset, but the headset's virtual keyboard is 
less ergonomic than a computer keyboard, which is why we're configuring 
annotations here.  
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To configure your annotations, Configuration>Annotations

 
 

 

1. Adding/deleting a user/asignee 
 

In the "Users/Asignees" tab, you can add or remove recipients (subcontractors, 
layout managers, etc.) or users (annotation creators). 

To add a recipient, click on "Add" and enter the recipient's e-mail address/name. 

 

Add e-mail addresses if your BIM management platform uses e-mail. 
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To add a recipient, click on "Add" and add the recipient(s) verbatim. 

 
 

 

To delete a recipient, click on the trash can icon to the left of the recipient's name. 

 
 

 

 

 

 

 

 

2. Edit titles and comments (annotations) 
You can configure annotation titles and comments. We advise you to identify your 
uses and their recurring problems, and to create a list adapted to your recurring 
problems. 

 For example, for a reservation check during the execution phase, a common problem 
might be: "Incorrect location", with a comment stating "The element is not correctly 
positioned".  
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Don't hesitate to go further and indicate all types of conflict, e.g. STR / ELEC Conflict, 
STR / HVAC Conflict, etc. AND you can even differentiate the consequence of the 
action, e.g. STR / ELEC Conflict - on-site modification, STR / ELEC Conflict - model 
recollection, STR / HVAC Conflict - on-site modification, STR / HVAC Conflict - 
model recollection, etc. 

 

Click on the "+ Add" button to add a new title and comment pair.  .  

The trash icon lets you delete a predefined title and comment. To modify the content, 

simply replace the existing text.    

Tips : 

#1: Leave a "to be completed" option for the last annotation. This can be useful if a 
problem was not anticipated at the outset. On site, select this comment, and the 
problem can be modified from your BIM management platform (such as BIM Track, 
BIM Collab, Solibri, AxeoBIM) or via an Excel sheet using photos taken during the 
annotation.or on an excel, using photos taken during the annotation  

#2: It is recommended to restrict annotation lists according to specific uses, and to 
create several annotation lists according to use cases. 

 

 

3. Configure annotation statuses 
Annotation statuses represent the evolution of your problems. Colors are associated 
with statuses.  

As a reminder, the numbered annotation dots are visible in immersive or tabletop 
mode in NEXT-BIM Explorer. The colors make it easy to understand the status of the 
problem.  

Configuration menu > Annotations > Topic Status 
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By default three statuses are available. add / modify / delete statuses according to 
your process.  

Example: 

 

To add " + ADD" button   

To delete trash icon   

 

 

 

 

 Modify status colors using RGB codes or the color palette by clicking on the colored 
square. 
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Tip #1: Maintain consistency of status and comments with your collaborative 
management platforms. 
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4. Setting priorities 
 

Priorities are used to classify new annotations according to their level of priority.  

Maintain the priority fields corresponding to the fields in your management 
platforms.  

 

       Use the "+ ADD" button to add a new priority type.. 

   Use the trashcan icon to delete a priority. To modify the content, simply replace 
the existing text. 

a) Configurer la propriété techniques par défaut  

It is possible to import technical properties (pset) into the comments of your 
annotations. You can configure a default property that will be automatically 
integrated into each annotation. 

To do this, follow the steps below: 

1. Access the annotations configuration by clicking on "Configuration" and 
then on "Annotations". 

2. Select the "Default properties" tab. 
3. Use the drop-down menu to select the name of the desired property set. 
4. Then select the property name from the drop-down menu. The value of 

this property will be included by default in each annotation. You can add as 
many default properties as you like.  

5. To select a property for a single annotation, you can do so directly from 
NEXT-BIM Explorer. 

By setting a default property, you simplify the annotation process by automatically 
adding relevant information to each annotation. This allows you to organize and  

 

structure your data more efficiently. 
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Integrating properties into the annotation comment allows you to add a specific 
piece of data.  

For example, specify an area, building, material phase etc. in the annotation 
comment. You need to know the properties of your project in order to be aware of 
the possibilities.  

In NEXT-BIM Configurator, you have the option of integrating a default property for 
each annotation. In NEXT-BIM Explorer, property modification is available to suit 
your contextual needs.  

Configuration > Annotation > Defaut Properties  

 

 
 

Use the drop-down menu to select the "Property Set Name" and "Property Name" to 
be included in each annotation. In this way, the property value will appear in the 
comment. 
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Example:

 
 

 

5. Retrieving/exporting annotations (.bcf or .xslx + .jpeg 
files) 

To retrieve or export your annotations in NEXT-BIM Explorer, follow these steps: 

1. In NEXT-BIM Explorer's Annotations tool, select the annotations you wish to 
retrieve or export. You can use the filters and search options to refine your 
selection. 

2. Once you've selected the annotations, you have two options for export: 
a. Export in BCF format: Click on the export button and choose the option 

to export in BCF format. This will generate a BCF file containing all 
selected annotations, together with associated information such as 
images and comments. You can save this file on your computer or 
transfer it to other collaborative BIM management tools to share issues 
with your collaborators. 

b. Export in XLSX + JPEG format: Click on the export button and choose 
the option to export in XLSX + JPEG format. This will generate an Excel 
file (XLSX) containing detailed information on each annotation, 
together with corresponding images (JPEG). This option is useful if you 
need a tabular view of your annotations. 

3. Once you've exported your annotations in the desired format, you can import 
them onto your computer by connecting your PC to your HoloLens using a 
USB connection or the Windows Device Portal. Transfer the exported files 
(.bcf or XLSX + JPEG) to your PC for use in other tools or to share with your 
team. 
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B. Configuring Properties: Importing Only Useful 
Properties (Property Filtering) 

To configure the properties to display in NEXT-BIM Explorer using the information 
tool, you can follow these steps: 

1) Go to the top menu "Configuration." 
2) Select the "Property Filtering" option. 

 
A properties configuration window will open, where you can define the properties to 
display in NEXT-BIM Explorer. 

• To add a property to the list of available properties, click on the property name 
in the "Whitelist" column. This property will then be available in NEXT-BIM 
Explorer. 

• To exclude a property from the list of available properties, click on the 
property name in the "Blacklist" column. This property will not be displayed in 
NEXT-BIM Explorer. 
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Tips :  

• If you want to import more properties than you remove, you can directly click 
on the property name to move it to the "Blacklist" column. 

• If you want to remove more properties than you import, you can click on the 
"Transfer all to blacklist" button and then click on the property names you 
want to exclude. 

By configuring properties in this way, you will only import the useful properties into 
NEXT-BIM Explorer. This avoids having an endless list when using the information 
tool and makes it easier to navigate and analyze the data in your model. 

Properties placed in the "Whitelist" column will be available in NEXT-BIM Explorer. 
Properties placed in the "Blacklist" column will not be available in NEXT-BIM 
Explorer. 
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C. Configuration Checklist : Preparing your checklists 
IMPORTANT: Using file-based rules in the checklist tool requires adding a rule for 
each IFC type and selecting the corresponding .IFC types contained in the file. If the 
.IFC types are not selected, the objects in the file will be considered as a group, and 
the number of objects in your checklist will not match the expectations. 

1. Method 1: From an Excel file (generated by a plugin) 
(e.g., BIM One for Revit) 

 

Create an Excel file using a plugin like BIM One for Revit. The Excel file should have a 
column with the title "GUID" and the GUIDs of the objects, a column with the title 
"object name" and the names of the objects, and a column with the title "checklist 
next-bim" or "next-bim checklist" containing the default status (e.g., "to be verified"). 

 
 

2. Méthode 2 : Prepare your checklist on NEXT-BIM 
Configurator  
a) Setting up default checklists 

Pour configurer vos checklist sur NEXT-BIM Configurator, vous pouvez suivre les 
étapes suivantes : 

1) Go to the "Configuration" menu. 
2) Select the "Checklist" option. 
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3) In the "Default States" section, modify the existing statuses by clicking on the 
text box of each status and replacing the text with your desired labels. 

 

 
The first status (e.g., "to be verified") will be the initial state of the objects imported 
into the checklist. The progression of statuses in NEXT-BIM Explorer follows the top-
down order of the statuses in your configuration. When you click on an object to be 
checked in HoloLens, the object transitions from status #1 ("to be verified") to status 
#2 ("Ok"). On the second click, the status changes from "Ok" to "Invalid." The states 
are sequential. 

 
4) You can also customize the colors of the statuses by clicking on "Color" and 

selecting a color from the palette or specifying an RGB value. 
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5) Use the arrows to modify the order of sequential statuses if needed. 
 

 

 
 

6) To add a new status, click on the "Add new state" button 
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 The default statuses will be automatically applied to all checklists unless you modify 
the status configuration within the editing of your checklist. 

 

 

 

 

 

 

 

b) Creating a new checklist 

 

1. Go to the "Configuration" menu in the software. 
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2. Sélectionnez l'option "Checklist". Select the "Checklist" option. 
3. Click on "New checklist" to create a new checklist. 

 
4. Rename the checklist according to your needs by clicking on the 

corresponding text box. 
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Setting up custom statuses for a checklist  

To customize the statuses for the checklist you are creating in NEXT-BIM Explorer, 
follow these steps: 

1. Go to Configuration > Checklist. 
2. Select the checklist you want to customize or create a new checklist using the 

"New checklist" option. 
3. In the "States" section, check the box "Use custom states instead of default 

states." This will allow you to define your own statuses for this specific 
checklist. 

4. Once you have enabled the custom option, you can modify the existing 
statuses by clicking on the text box of each status and replacing the text with 
your desired labels. 

This feature allows you to apply specific statuses only to this checklist. 
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By object - Creating a checklist by object 

The "By object" method is suitable when you want to check specific objects by 
dragging and dropping from the hierarchy or creating a selection using the "Find" 
tool or the selection function (CTRL+Right-click). Here's how to use this method: 

 

1. In NEXT-BIM Explorer, open the "Checklist" tab. 
 

 
2. Create a new checklist. 
 

 
3. Go to the « By object” panel 

 
4. To add objets to the checklist, you have two options  
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• Drag and drop: You can select objects in the virtual model hierarchy and drag 
them to the checklist area. The objects will be automatically added to the 
checklist. 

• Selection using the "Find" tool or selection function: Use the "Find" tool to 
search for specific objects or make a selection by holding the CTRL key and 
right-clicking on the objects. Then, in the "By objects" panel of the Checklist 
tab, click the "Add selected objects" button. The selected objects will be 
added to the checklist. 

By using this method, you can quickly create a checklist by selecting specific objects, 
either by dragging and dropping from the hierarchy or by making a selection using 
the "Find" tool or the selection function. This allows you to easily check the relevant 
objects for your control process. 

 

.  

 

 

Example : 

To search for a specific type of door in my "Find" tool. 
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Add its result to my selection: "Append". 

 
Add my selection to my checklist: Configuration > Checklist > By Object > Add 
selected objects. 
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By filters - Creating a checklist via filters 

 

1. Dans le menu "Configuration", sélectionnez l'option "Checklist". In the 
"Configuration" menu, select the "Checklist" option. 

 

 
2. Click on "New checklist" to create a new checklist. 
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3. In the checklist creation window, go to the "By filters" tab. 
 

 
 

4. Rename your checklist 
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5. Create filters using sorting rules to group the desired objects. Sorting rules 
can be based on name, type, files, properties, floors, etc.  
 

 
 

6. Add the necessary rules based on your selection criteria. 
 

7. Rename your filter according to its content. 
 

 
 

8. Close the filter window to import it into the checklist and preview the 
checklist using the "Preview" button. 
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9. The filter is created. 

 
 

10. Close the checklist 
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11. Your checklist has been created. 

 

 
 

Export a checklist from NEXT-BIM Configurator to an existing .nbim file (without 
generating a .nbim file). 
 

If you want to export a checklist without generating a .nbim file: 

 
1. Go to Configuration > Checklist > File > Export XLSX Checklist. 

 

 
 

2. Save the file to your desired location on your PC. 
 

3. Then, import this file into the file explorer of your HoloLens. 
 
 

4. In NEXT-BIM Explorer, use the "Import Checklist" button in the checklist tool 
to select the newly imported checklist. 

 

 

 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 

Checklist multistep / Liste de contrôle à plusieurs niveaux 

Multistep checklist or checklist with multiple levels is used to provide instructions to 
the user for validating a type of object. Each object needs to fulfill certain criteria to 
be considered compliant.  

Here's how to configure a multistep checklist in NEXT-BIM Explorer: 

1. In the "Checklist" tab, when creating a new checklist, check the "[OPTIONAL] 
Multistep checklist" box. This will apply the criteria and steps to each checklist 
that doesn't have specific criteria. 

2. Click the "Add new criteria" button to add the necessary criteria to your 
checklist. You can add as many criteria as needed. 

3. For each criterion, define the conditions that need to be met for the object to 
be considered compliant. For example, you can define the following criteria: 
horizontal section, vertical section, and squareness. 

4. For each criterion, define the status that will be assigned to the object based 
on the step. For example, if only one criterion is met, the object can be 
considered "not correct." If two criteria are met, the object can still be 
considered "not correct." If all criteria are met, the object can be considered 
"correct." 

By using this method, you can configure a multistep checklist with specific criteria for 
each step. This will allow the user to easily check if the objects meet the required 
criteria at each level of the checklist. 

 

Applying criteria ( by default ) to all checklists  

This method allows you to apply the same criteria and steps to each checklist that 
doesn't have specific criteria. 

Check the "[OPTIONAL] Multistep checklist" box. 
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Add as many criteria as needed using the "Add new criteria" button. 

Define the criteria. 

Define the status based on the step. 

Example: For my checks: 

• I want to know if the object needs to be verified, if it is correct or incorrect. 

• I want to verify the position, size, and color of the objects. 

I would add these 3 states and 3 criteria to my checklist: 
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Then, for each step, I would define a status.  

If only one criterion is met, my object is not correct.  

If two criteria are met, my object is not correct.  

If three criteria are met, my object is correct. 

 
 

This configuration will be applied to all my checklists. 

 

Appliquer des critères spécifiques pour une checklist  
 

Si vous souhaitez appliquer des étapes et des critères spécifiques à une liste de 
contrôle précise, vous devez créer vos étapes/critères à l'intérieur de la liste de 
contrôle. 

 

If you want to apply specific steps and criteria to a specific checklist, you need to 
create your steps/criteria within that checklist. 

1. To apply specific criteria to a particular checklist, follow these steps: 
2. In the "Checklist" tab, click on "New checklist" to create a new checklist. 
3. In the checklist creation window, go to the "States" tab. 
4. Check the box "Use custom states instead of default states". This will allow 

you to define specific statuses for this checklist only. 
5. Also, check the "[OPTIONAL] Multistep checklist" box to indicate that you 

want to use a specific multistep checklist for this checklist. 
6. Click the "Add new criteria" button to add the necessary criteria to your 

checklist. 
7. For each added criterion, define the conditions that must be met for the object 

to be considered compliant with this step of the checklist. 
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By following these steps, you can create a multistep checklist with specific criteria 
for each step. This approach allows you to customize the criteria based on the 
validation requirements for each specific object type or process. 

Example: We want to implement a multistep checklist to control my reservations. For 
my reservations to be valid, the following criteria must be met: horizontal section, 
vertical section, squareness/angularity. 
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D. Visibility list 
In NEXT-BIM Explorer, you have the ability to quickly show or hide object lists 
according to your needs. These visibility lists are useful for facilitating visualization 
based on specific use cases.  

In NEXT-BIM Explorer, you can: 

• Show or hide objects based on: 
o Files, 
o IFC types, 
o Individual objects. 

It is unnecessary to create custom lists solely based on these rules except if you 
want to save your configuration as a favorite for quickly navigating between lists. 

• Display/Hiding objects from a custom visibility list: 
• Accumulate objects from multiple visibility lists: 

 

In summary, visibility lists in NEXT-BIM Explorer allow you to manage object visibility 
quickly and in a customized manner. You can choose to display only objects from a 
specific list, combine objects from multiple lists, or hide objects according to your 
needs. Additionally, you can also use the display options based on files, IFC types, 
and individual objects for better visibility management. 

Feel free to configure visibility lists that are useful to you 
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1. Creating a visibility list  
 

Go to the "Configuration" menu and select "Visibility list". 

 
a) Create a new list 

 

1. Click on "New list" to start configuring your visibility list. 

 

 

 
 

2. Rename your visibility list to easily identify it in NEXT-BIM Explorer. 
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3. You can now choose from different options to create your visibility list. 

 

 

b) Create a visibility list by Type (Class ifc) 

• Select "By type". 
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• The left column represents the object types that will be visible in the visibility 
list. 

• The right column represents the object types that will not be visible in the list. 
• The "Preview" checkbox allows you to see the list in NEXT-BIM Configurator. 

 
 

c) Create a visibility list by File  

• Select « By file »  
 

 
 
 

• Check the corresponding box to include a file in your visibility list. 
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• The "Preview" checkbox allows you to see the list in NEXT-BIM Configurator. 

 

 
 

d) Create a visibility list by filter   
 

• Select « by filter » 

 
• Create a new filter by clicking on "Create and add a new filter" or use an 

existing filter. 
• Give a name to the filter. 
• Apply rules to the filter to define visibility criteria. 
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• Close the filter once the rules are configured. 
• The "Preview" checkbox allows you to see the list in NEXT-BIM Configurator. 

 

Example :  

 

 
Etape 1 : Rename your visibility list   

Etape 2 : Create a new filter: « create & add new filter » 

Etape 3 : Rename your filter  

Etape 4 : Apply specific rules  Apply specific rules 

Etape 5 : Close the filter 
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“Preview”  : Display your visibility list in the 3D view. 

“Back” : " End of creating your visibility list. 
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2. Materials (colors) 
Configuring object colors is important for improving visualization and understanding 
in NEXT-BIM Explorer. 

To configure object colors, follow these steps: 

1. Go to the “Configuration” menu and select “Materials” 

 
 

2. In the "By object" section, you can individually modify the colors for each 
object. Click on the object you want to modify the color for, then choose the 
desired color from the color palette. 

3. In the "By IFC types" section, you can modify colors for different IFC object 
types. Select the object type you want to modify the color for, then choose the 
color from the color palette. 

4. In the "By file" section, you can modify colors for each file. Check the box next 
to the file you want to modify the colors for, then choose the color from the 
color palette. 

It is recommended to use different shades of colors to enhance the visualization and 
understanding of objects in NEXT-BIM Explorer. You can also test different colors to 
determine which ones suit you best. 

For better visualization, we recommend the following colors: 
 
 
 
 
FLOOR CODE COLOR: #E1C7C7 
WALL CODE COLOR  : #F5F778 
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Multiple shades are possible, and feel free to test other colors to find the ones that 
suit you best. 

Note: Color prioritization is applied. The priority rule is as follows: objects > filters > 
types > files. For example, if you change the color of a single object to red (e.g., a 
wall), and then change the color of an IFC type (Ifcwall) to blue, the color (red) 
assigned to the object (the wall) will be preserved and take priority over the color 
applied to the type (blue). Therefore, the wall will appear in red and the others in 
blue. 

1. Modifiying the color 
To modify the color, directly select the color tool from the color palette or apply your 
RGB code. 
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2. Modifiying the transparency 
 

The "Preserve Opacity" checkbox keeps the original transparency. 

 

 
 

To change the transparency, uncheck the "Preserve opacity" checkbox and adjust 
the "1.000" slider to the desired value (click and drag the mouse to the left to 
decrease the value). 
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3. Coloring by files  
To colorize by files, follow these steps: 

 

1. Go to the "Configuration" menu and select "Materials". 
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2. In the "By file material" section, click on "Add".

 
 
 

3. Select the file you want to configure by clicking on the corresponding 
checkbox. For example, select the file "Clinic_A". 
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4. To modify the color of the selected file, click on the "Color" box. 

 
5. Choose the desired color using RGB codes or the color palette tool.  

6.  

 
 

7. If you want to apply a color to another file, press the “ADD” button at the 
bottom and repeat the previous steps to configure the color for the additional 
file. 

 

4. Coloring by class IFC  ( by type ) 
To know : By default two configurations are already available in the IFC types. We 
have added a texture to the walls and floors to enhance visualization. The color of 
the walls and floors can still be modified. 

 

To colorize by type (IFC class) in NEXT-BIM Explorer, follow these steps: 

1. Go to the "Configuration" menu and select "Materials". 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 
2. In the "By type Material" section, click on "Add". 

 
3. Once you have clicked on "Add", the available IFC types will be displayed on the 
right. 
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4. Select one or more IFC types by checking the corresponding checkboxes to apply 
the same color. 

 

5. Apply a color to the selected types using the color palette tool or by entering RGB 
codes. 

 
 

6. If you want to apply a new color to other IFC types, click the "Add" button at the 
bottom and repeat the previous steps. 

 

By using this feature, you can colorize different IFC object types in NEXT-BIM 
Explorer, which facilitates the visualization and understanding of the various 
elements in your model. 
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5. Coloring by filters  
To colorize by filters, follow these steps: 

1. Go to the "Configuration" menu and select "Materials". 
 

 
 

2. In the "By Filters" section, click on "Add". 
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3.  
• To apply a new color based on an existing filter from the "Open Filter Library", 

simply drag and drop the desired filter from the filter window to the "filters" 
column in the "By filter material" section. You can select the appropriate filter 
from the available filter library. 

• If you want to create a new filter, click on "Create & add new filter". This will 
allow you to define the filtering rules for your new filter. 
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4. Once you have selected or created the filter, click on the "Color" box to apply 
the desired color using the color palette tool or RGB codes. 

 
By using this feature, you can apply specific colors to objects that match the selected 
filters. Filters allow you to define rules for selecting objects based on their properties 
or characteristics, allowing you to visually identify them in NEXT-BIM Explorer. Make 
sure to choose distinct and meaningful colors for each filter to facilitate the 
visualization and understanding of filtered objects in your model. 
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6. Coloring by object  
To colorize by object, follow these steps: 

1. Go to the "Configuration" menu and select "Materials". 
 

 
 

2. In the "By Object Material" section, click on "Add". 
 

3. You can add objects to your configuration in different ways: 

• Drag and drop objects from the hierarchy into the "By Object Material" 
tab. 

• Right-click on the object (from the 3D view or hierarchy) > "Materials" 
> "Edit Existing Object Material". 
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• You can also configure multiple objects at once by including them in 
your selection (box selection or CTRL + Left-click), then add the 
selected objects to your list of objects to be colored. 

 

 

 

 

 

 

 

 

4. Once you have added the objects, you can modify their color using the color 
palette tool or by entering the corresponding RGB codes. 
 

 
 

5. If you want to add other object lists, click on "Add". 
 

6. By using this feature, you can apply specific colors to individual objects or 
groups of objects in your model. This allows you to customize the visual 
representation of objects according to your needs. 
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7. Make sure to choose distinct colors for each object or group of objects to 

facilitate visual distinction when exploring your model. 

 

8. Once you have added the objects, you can modify their color using the color 
palette tool or by entering the corresponding RGB codes. 
 

 
9. If you want to add other object lists, click on "Add". 

By using this feature, you can apply specific colors to individual objects or groups of 
objects in your model. This allows you to customize the visual representation of 
objects according to your needs. 

Make sure to choose distinct colors for each object or group of objects to facilitate 
visual distinction when exploring your model. 
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E. Tabletop 
The Tabletop mode is a scaled-down model in the headset that allows you to 
position yourself inside the building at a 1:1 scale. It appears when opening the 
.nbim file. 

In the Tabletop model, we cannot load all elements due to the performance 
limitations of the HoloLens. Therefore, it is possible to load up to 1 million triangles. 
A default configuration has been implemented with a priority rule based on types. 

Note: Floors are required to immerse yourself in the model, while walls provide 
reference points. 

1. Configuring the Tabletop Mode by Type 
1. Go to the "Configuration" tab and select "Tabletop" 

 

 

 
 

2. The "Whitelist" displays the types of IFC objects that will be visualized in 
Tabletop mode, while the "Blacklist" contains the types of IFC objects that will 
not be imported. 
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3. To change the status of an IFC type, click the corresponding button for that 
type. 
 

4. The number of remaining triangles that can be imported into the whitelist is 
displayed at the bottom left of the window. For example, if it shows 920,235 
triangles, it means you can still import objects up to that number of triangles. 
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5. Some IFC object types, such as "Ifcflowfitting," may exceed the remaining 
triangle limit displayed at the bottom left as "920,235 triangles remaining." In 
this case, the type is shown in red. 
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6. If you still want to display the "Ifcflowfitting" type in Tabletop mode, you can 
do so by moving it to the whitelist and then moving it up in the list using the 
arrows until it is no longer displayed in red. However, this will no longer 
display the IFC types below IfcFlowFitting. 
 

7.  
 

8. An alert message will appear indicating that everything below IfcFlowFitting 
will be ignored in Tabletop mode. 

9. If you still have remaining triangles, you can move up other IFC types 
displayed in black. If you want to display only a portion of objects from a type 
in red, you can check the configuration by filters. 
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2. Tabletop filters 
 

The configuration by filters  will be used most often for Navisworks projects 
exceeding one million triangles. Additionally, the purpose of filters for IFC 
configurations is to display in the HoloLens objects of an IFC type that exceed or 
surpass the one-million-triangle limit. This means being able to sort objects by a rule 
other than IFC types to display a portion of the objects from that IFC type. 

 

1. Go to the "Configuration" menu, select "Tabletop," and choose the "Filters" 
tab. 

 
2. Click on "Create & add new filter" to create a new filter specifically for 

Tabletop mode, or "Open filter library" to drag and drop an existing filter. 

 
3. Once you have created or added your filter, it will be automatically included in 

your Tabletop mode. 
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Filters take priority over the classification of object types (IFC classes). This means 
that if you have configured a filter for a specific object type, that filter will be applied 
even if it is present in the whitelist or blacklist. 

Filters allow you to manage and control the IFC object types that will be displayed in 
Tabletop mode on the HoloLens more precisely, exceeding the imposed triangle limit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

F. Configuration Storey (floors) 
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To reorganize your storey hierarchy in NEXT-BIM Configurator, follow these steps: 

1. Go to the "Configuration" menu and select "Storeys". 
 

 
 

 

2. In the "Storeys" window, you have two options for reorganizing your files: a 
 

a) To reorganize all files: 

• Click on the "Auto sort all remaining files storeys" button. 
• This feature allows you to create a storey hierarchy based on the information 

contained in the .ifc files. 

b) To reorganize a specific file: 

• Select the file from the displayed list of files. 
• Click on the "Auto sort remaining file storeys" button. 
• This feature allows you to reorganize only the selected file into a storey 

hierarchy. 
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Reorganize  all files with one click 

Reorganize only a specific file   

3. Once the organization is done, your new storey hierarchy will be available. 
 

• Go to the "Windows" menu and select "Hierarchy", then choose the "Storey" 
option. 
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• The "Storey" window will display your reorganized hierarchy, showing the 

different storeys of your building. 
• You can use this storey hierarchy for specific storey-based selections or for 

better organization and visualization of your files. (voir ici).  
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G. Removed Objects 
 

To view all the elements that will not be loaded and modify this list, go to 
Configuration > Removed Objects. 

 

 
 

The list of all the elements that will not be loaded will appear (these are the objects 
where you have applied “Removed object / types / storey / files from output” ) 

 
To restore a removed object to thefinal file, click on > “Re-add” on the dsired object, 
or click on “Re-add all” to restore multiple objects with a single click 

 

 
 If you have removed distant objects to avoid hindering the conversion of your .nbim 
file, these objects should be listed here. 
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H. Configuration of NEXT-BIM Explorer Settings 
 

To configure the default settings of NEXT-BIM Explorer, follow these steps: 

1. Open the "Configuration" menu from the top menu bar. 
2. Select the "Explorer" tab from the dropdown menu. 

You will now see the different configuration settings available. In this section, you 
can enable or disable various settings according to your preferences. 

 
You will now see the different configuration settings available. In this section, you 
can enable or disable various settings according to your preferences. 

 

1. Configure your interface :  

 
 

• « Generate Minimap » : Enable this option to generate a minimap in NEXT-BIM 
Explorer. The minimap provides an overview of the model and facilitates 
navigation. If this feature is disabled, the generation of the .nbim file will be 
faster, but the minimap will not be available. 
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• "Show Minimap By Default": Check this box if you want to display the 
minimap by default when entering immersive mode. 
 

• « Show Voice Command List By Defaull” : Check this box to display the 
contextual voice command list in your holographic view. 

 

2. Configure your visibility  
 

 
 

• "15m / 25m / 50m Default view distance": Select the default viewing distance 
in NEXT-BIM Explorer. We recommend choosing a distance of 15m, especially 
if your files are large and complex. 
 

• "Show All Floors By Default": Enable this function if you want to visualize 
across multiple floors. Recommended setting is "Off." 
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3. Alignement Configuration 
a) Configuration of the offset between the modeled floor and the actual 

floor  

If the modeled floors do not match the actual floors in certain areas, you can 
configure an offset in NEXT-BIM Explorer. This allows you to adjust the position of 
the floor with a single click. 

1) Go to the "Explorer" tab > "Alignment" > "Default Floor Offset 

 
2) Specify the offset value. In NEXT-BIM Explorer, the following values (in cm) 

are already available: -15 / -10 / -5 / +5 / +10 / +15. 
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b) Configure the complementary tool for continuous matching alignment : 
Quick realignement  targets  

 

 

To configure the quick realignment tool using targets in NEXT-BIM Explorer, follow 
these steps: 

1. First, make sure you have previously modeled the targets in your .ifc files. 
 

2. Access the "Configuration" menu and select "Explorer." 
 

 
 

3. In the "Alignment" tab, click on the "Alignement target" button and then 
"Create & add new filter" to create a new filter. 
 

 
 

4. Give your filter a name, for example, "Targets," to distinguish it from other 
filters. 

5. Configure the filter to include all the targets you want to use for quick 
realignment. 
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6. If you want to filter targets by name, you can specify the target's name in the 
filtering criteria. 

7. If you want to filter targets by file, you can specify the name of the file 
containing the targets in the filtering criteria. 

8. If you want to filter targets by properties, you can specify specific properties 
of the targets in the filtering criteria. 

9. Once you have configured the filter to include the desired targets, click the 
"Back" button to save the filter. 

10. Now you can use the quick realignment tool using targets, referring to the 
NEXT-BIM Explorer video tutorial for more information on its usage. This tool 
allows you to quickly realign your model using the targets you have previously 
filtered and configured.  

By setting up a specific filter for targets and using the quick realignment tool using 
targets, you can achieve precise and efficient realignment of your model in NEXT-
BIM Configurator for areas that are not conforming to the model or have complex 
environments (no reference objects to be integrated). 

 

c) Configurer continous matching : Enhancing continuous alignment 
realiability  
 

By default, NEXT-BIM Explorer performs continuous alignment on all vertical planar 
surfaces belonging to structural IFC categories such as IfcWall, 
IfcWallStandardCase, IfcSlab, IfcBeam, etc. 

• If you want to disable this limitation and consider all vertical planar surfaces, 
you can uncheck the corresponding option in the continuous alignment tool 
settings in NEXT-BIM Explorer. To further customize continuous alignment, 
you can use rules to select the objects on which the system will perform 
continuous alignment. 

• You can define rules based on object properties, such as their IFC type, name, 
properties, floors, etc. 

• By using appropriate filters and criteria, you can determine the objects on 
which continuous alignment will be applied. 

To configure custom continuous matching in NEXT-BIM Explorer, follow these steps: 

1. Access the "Explorer" menu in NEXT-BIM Configurator. 
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2. Select the "Alignment" option from the dropdown menu. 
 

 
3. In the "Alignment" submenu, choose the "Continuous Matching Filter" option. 
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4. A filter configuration window will open, allowing you to customize the rules 
for continuous alignment. 
 

5. Once you have configured the rules according to your needs, click the "Back" 
button to save the configuration of the custom continuous matching filter(s). 

 

6. From now on, NEXT-BIM Explorer will use the rules you have defined to 
perform continuous alignment on the selected objects.  
 

By customizing the continuous alignment settings in NEXT-BIM Explorer, you can 
tailor the system to your preferences and specific needs. This will enable you to 
achieve more accurate and reliable alignment of your model in the software. 
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I. Preconfigure Immersions Points  
To preconfigure interest points in NEXT-BIM Configurator, follow these steps: 

1. Access the "Configuration" menu in NEXT-BIM Configurator. 
 

2. Select the "Interest Point" option from the dropdown menu. 
 
 

 
 

3. Once in the interest points window, you can position interest points at specific 
locations in your model. 
 

4. Click the "Add" button to add a new interest point. 
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5. You can name the interest point and specify its position using the mouse. 
 

6. Repeat steps 4 and 5 to add as many interest points as needed. 

 

 

When users access the TableTop model in NEXT-BIM Explorer, they will be able to 
select a preconfigured interest point and be immediately positioned at that location 
in the 1:1 scale model. This facilitates navigation and immersion in specific areas of 
the model, providing a smoother and more convenient user experience. By 
preconfiguring interest points in NEXT-BIM Configurator, you enhance the user 
experience in NEXT-BIM Explorer by allowing users to quickly and accurately 
position themselves at key locations in the model. 
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XII. BEFORE .NBIM CONVERSION  
A. Cleaning up the model 

Cleaning up the model is a compulsory step in order to avoid any discrepancies in 
tabletop mode (display above the blue circle or model too small) and also for your 
future conversion to .nbim. Any objects far from the centre of the project will 
interfere with either the tabletop display or the conversion to .nbim. 

1.  Automatic cleaning  
Automatic clean-up is available. When importing your files, if distant objects are 
detected, an "outliers" tab will open.  

A list of remote objects will appear. Click on the name of the object to view it.  

If, after checking, you wish to remove these objects, click on "remove outliers from 
project". 

2. Nettoyage manuel 
 

To clean your model manually, follow these two steps:  

1) Display your model in top view. Click on the camera icon.  .  
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Click on the "down" arrow 
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Make a selection box as close as possible to the edges of your 3D model: Hold down 
Ctrl + Right Click.  

Once your model is selected, the selection will be highlighted in yellow.  
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Open the selection panel by clicking on "X objects in selection".
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Invert your selection, and all objects not in your selection box will be selected. 
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Click on "Remove all selected objects from output" to remove all unwanted 
objects. 

 
Then repeat the operation with a side view.  
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B. Cutting your model (necessary for large, dense 
files) 

 

To improve NEXT-BIM Explorer's performance in very large models, it is advisable to 
cut your model according to its use. For example, if you are carrying out an 
inspection at level 1, the other levels are not necessarily necessary, or if a building 
component is not necessary for your use, delete it. 

There are several ways of cutting your model. 

 
1. Use the "Find" tool to add the part of the model to be 

imported to your selection box.  
To do this, your .ifc files must be sorted by technicals. 

Pour cette manière, vos fichiers .ifc doivent être classés par corps d’états. 

 

 
In this example, we only want to import level 1 of the building, and you don't 
want to include any of the MEPs.  
Select the Architecture and Structure file from the "Files" drop-down menu 
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Select the first floor; for information, the search will be carried out in all the storeys 
on the first floor, despite the file display. 

 
 

 
 

The number of objects in the search appears in the "results" box. 

To add this search to your selection, click on "Append". 
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The selection window will open automatically. To preview your selection, click on 
"Preview selection". 
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We want to keep this level 1. We are going to invert our selection to remove the 
objects from our selection.  

Click on "invert selection". 

 
 

Finally, remove the objects from your project by clicking on "Remove selected objects 
from output". 

Your cut is finished. 

Please note: Deleted objects are kept in your Configuration>Removed Objects tab. 

2. Use Storey's Configuration tool to reorganise your 
hierarchy by level and cut out the model by level.. 

 

To perform a level cut using the Storey Configuration tool in NEXT-BIM 
Configurator, follow these steps: 
Access the Storey Configuration tool: In NEXT-BIM Configurator, go to 
Windows > Hierarchy > Storeys. 
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1) Configure your storeys: Make sure that you have correctly configured 
your levels in your CAD software (for example, Revit) so that the 
management of storeys is based on these levels. The levels you wish to 
import into NEXT-BIM Configurator must be correctly defined in your 
CAD software.  

2) Configure your levels in NEXT-BIM Configurator ) (see here) 
3) Hide unwanted levels: In the Storeys tab, hide the levels you do not 

wish to import into NEXT-BIM Configurator by clicking on the "eye" 
icon corresponding to these levels. For example, hide the "Roof-main" 
and "TOF footing" levels

 
 
 

4) Make a selection box: Use the CTRL + Right Click key combination to 
make a selection box around the current view. This will select all the 
objects visible in the levels you have chosen.
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7. Re-display hidden levels: Click on the "crossed out eye" icons corresponding 

to the levels you have previously hidden to re-display them. 
 

 
8. Invert the selection: In the current selection, invert the selection using the 

appropriate options. This will select all the objects which are not part of your 
initial selection box 

.  
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9. Remove selected objects from output: Click on the "Remove all selected 

objects from output" option to remove all selected objects from the output. 
This will cut the model by level, leaving only the objects on the levels you have 
selected. 
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CAUTION: if a duct passing through two levels (level 01 and level 02) has been 
referenced on level 01, storey management will take this reference into account and 

will not appear in level 02. 
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XIII. Generating the .nbim file and importing 
it into your HoloLens 2 

To generate the .nbim file and import it into your HoloLens 2, follow these steps : 

1. Make sure you have cleaned up your model before converting it. You can refer 
to the instructions provided earlier to carry out this step (see here) 

2. In NEXT-BIM Configurator, go to the "File" menu and select "Generate .nbim". 

 
 

3. Choose the location where you want to save the .nbim file on your computer 
and click "Save". 

 
 

 

4. Once the .nbim file has been saved, you have two options for importing it into 
your HoloLens 2 : 
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A.  Import via your USB-C device : 
1. Connect your HoloLens 2 to your computer using a USB-C cable. 
2. Open the file explorer on your computer and access the HOLOLENS device. 

 
 

3. Navigate to the "Internal Storage" folder and then open the "Documents" 
folder. 

 
   

 
 

4. Copy the .nbim file to the "Documents" folder. You can create a specific folder 
for your project if you wish. 
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B. Import via Windows Device Portal : 
1) Make sure your computer and HoloLens 2 are connected to the same Wi-Fi 

network. 
 

2) Obtain the IPv4 address of your HoloLens 2 by using the voice command 
"What is my IP?" on your HoloLens 2 or by accessing the headset settings 
(Settings/Network & Internet/Wi-Fi/[Your network]/Advanced options/IPv4). 
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3) In your web browser (Google Chrome or Mozilla Firefox recommended), enter 

the IPv4 address of your HoloLens 2. 
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4) If necessary, accept the security alerts and continue to the dangerous site. 
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5) Log in with your username and password (the ones you set when you first 

logged in). 

 

 

 

 

 

 

 

 

 

 
 

6) Go to System > File Explorer in the Windows Device Portal. 
 
 

 
 

 
 
 

7) Navigate to the "Documents" folder and create a new folder for your project. 
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8) Go to the new folder and click on "Choose a file" to select the .nbim file to be 
imported. 
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9) Click on "Upload" to finalise the file import. The .nbim file will be imported into 
your HoloLens 2. 

 

 
 

10) Once the .nbim file has been imported into your HoloLens 2, you will be 
able to open and explore it using the NEXT-BIM Explorer application for an 
immersive experience of your model. 
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XIV. Viewing annotations in NEXT-BIM 
Configurator (BCF Viewer). 

To view annotations in NEXT-BIM Configurator using the BCF Viewer, follow 
these steps:  
 

1) NEXT-BIM Configurator, go to the "Windows" menu and select "BCF 
Viewer". This will open the BCF Viewer in a new window. 
 

 
2) To import a BCF file containing the annotations, click on the "File" button in 

the BCF Viewer, then select "Import BCF...". 
 

 
3) In your file explorer, navigate to the location where you saved the BCF file on 

your computer. Select the file and click "Open" to import it into the BCF 
Viewer. 
 
If you have exported BCF files from NEXT-BIM Explorer to your HoloLens 2, 
you can access these files in the "Pictures" or "Images" folder on your 
HoloLens 2. When importing, make sure you select the appropriate BCF file 
from this location. 
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Once the BCF file has been imported, you will be able to view the annotations 
created in NEXT-BIM Explorer in the BCF Viewer of NEXT-BIM Configurator. 
The annotations will be displayed with their corresponding information, such 
as comments, images, links, etc. This will allow you to view and work with the 
annotations in the NEXT-BIM Configurator environment. 

 

XV. Additional information 
A.  Incorrect georeferencing of models 

When exporting .ifc files, check the georeferencing parameters so that your different 
.ifc models are superimposed.  

a) IFC EXPORT repositioned FROM REVIT 
The purpose of this note is to set out a simple method for exporting a project with 
linked mock-ups to IFC and obtaining correctly georeferenced IFCs.  
TESTS CARRIED OUT WITH REVIT 2018 

2 RVT models linked and repositioned correctly in Revit. 

The whole project is exported in IFC. 

  
   

Viewed in Revit 

 
Viewed in Navisworks 
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When viewing the IFCs exported from Revit in Navisworks, a discrepancy can be 
seen. 

 

CORRECTIONS MADE IN REVIT 
 

 
 

Click on EXPORT COORDINATES and then click on an element belonging to EACH 
linked file in the project. 

Each time the dialogue box below appears, check that "Internal (active)" is selected 
in the "Select position in" list. Then click OK. 

 

  
Then SAVE the project.  
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Answer SAVE NEW POSITION for each linked file.

 
b) ADVANTAGES OF THIS METHOD : 

No need to manipulate the project base point and topographic point.  

If the linked files are deleted (and not simply unloaded), all you have to do is link 
them again by choosing the positioning option : TO SHARED LOCATION 

 

B. Why are there two executables, Converter.exe and 
Configurator.exe? 

NEXT-BIM Converter and NEXT-BIM Configurator are two distinct executables, each 
with its own role in the process of preparing and converting IFC files into NBIM 
format. 

1. NEXT-BIM Converter: 
• This is the main tool for converting IFC files into NBIM format. 
• It is used to convert raw IFC files into a format compatible with the NEXT-BIM 

mixed reality environment. 
• It converts geometric data, properties and other information required for 

mixed reality display. 
• NEXT-BIM Converter is essential for generating the NBIM file that can be 

used in NEXT-BIM Configurator. 
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2. NEXT-BIM Configurator: 
• This is a complementary tool for preparing and configuring the mixed reality 

immersion experience. 
• It offers functionalities such as view configuration, filter customisation, floor 

management, definition of points of interest, etc. 
• NEXT-BIM Configurator makes it easy to prepare the model for optimum 

immersive viewing in HoloLens or any other compatible device. 
• When generating the NBIM file in NEXT-BIM Configurator, NEXT-BIM 

Converter is called in the background to perform the actual conversion of the 
IFC files into NBIM format. 

• It is important to note that NEXT-BIM Converter should not be deleted as it is 
required to perform the conversion of the IFC files. The two executables, 
NEXT-BIM Converter and NEXT-BIM Configurator, work in tandem to provide 
a high quality immersive experience with the generated NBIM files. 

C. Conversion time 
 

The conversion time depends on three factors.  

1. Size of the IFC / Navisworks file: As a general rule, the larger the file, the 
longer the conversion time. This is due to the high number of geometric 
elements, properties and information to be processed during conversion. 

2. Computer performance: A computer with a powerful processor and sufficient 
memory will allow faster conversion. Higher hardware resources can speed 
up the conversion process. 

3. Generating the minimap : The minimap is a miniature view of the model that 
can be displayed in NEXT-BIM Configurator. Its generation can influence the 
conversion time. If you do not wish to view the minimap, you can deactivate 
this option in the interface settings. To disable minimap generation in NEXT-
BIM Configurator, you can follow these steps: 

Go to the Configuration tab in NEXT-BIM Configurator. 

Select the "Explorer" tab. 

Look for the "Generate minimap" option in the interface settings. 

Deactivate this option to avoid generating the minimap during conversion. 
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By deactivating minimap generation, you can convert your NBIM files more quickly. 
However, please note that this may also limit some of the minimap-related viewing 
features in NEXT-BIM Configurator. 
D. The difference between "Remove Object from 

output" and "Hide Object 
The difference between the "Remove Object from output" and "Hide Object" options 
lies in their effect on file viewing and preparation, as well as their impact on 
immersion. Here is a more detailed explanation: 

1. 'Hide Object': This option allows you to hide a specific object when viewing 
and preparing files in NEXT-BIM Configurator. The hidden object will not be 
visible during these stages, but when immersed in NEXT-BIM Explorer, the 
object will be visible. In other words, the object is only hidden in the 
preparation interface, but is loaded and visible when immersed. 

2. "Remove Object from output": This option goes a step further by completely 
removing the object from the final output. Not only is the object hidden, it is 
also excluded from the output file (for example, when converted to .NBIM 
format). This means that when immersed in NEXT-BIM Explorer, the object 
will not be loaded or visible. It is completely excluded from the immersive 
experience. 

The use of these options depends on your specific needs and the optimisation of 
your immersion. Here are some common reasons for not loading an object or type of 
object: 

• Performance optimisation: If your IFC file is large and you want to 
improve the fluidity of the visualisation, you can choose not to load 
certain objects or object types that are not necessary for your use. This 
reduces the load on the software and improves overall performance. 

• Eliminate clutter : Sometimes there may be objects or parasitic 
elements in the model that are not relevant to your use or that could 
disrupt your immersive experience. By removing these objects from the 
output, you can focus on the essential elements and eliminate 
unwanted distractions. 

In summary, 'Hide Object' visually hides an object during file preparation, but makes 
it visible during immersion, while 'Remove Object from output' completely excludes 
the object from the output, making it invisible during immersion. These options offer 
flexibility in customising your immersive experience to suit your specific needs 

 

https://next-bim.com/espace-client/
https://next-bim.com/espace-client/


                                                                                                                                                                                                                      

Retrouvez tous les documents de supports sur votre espace client : https://next-bim.com/espace-
client/ 

 

 

E. Conflit GUID 
When you see a black triangle to the right of your files in NEXT-BIM Configurator, 
this indicates that there are objects with the same GUID (globally unique identifier) in 
two different files. This GUID conflict can lead to visualisation problems in HoloLens. 

 
 

To resolve this problem, you have several options: 

 

1) Right-click on the triangle: By right-clicking on the triangle, you have the 
following options: : 
 

• "Add conflicting objects in this file to selection": This option adds conflicting 
objects from this file to your current selection. 

• " Add conflicting objects from other files to selection": This option adds 
conflicting objects from other files to your current selection. 

The quickest options for removing conflicting objects from the project are at the 
bottom: 

• Remove conflicting objects from this file from output": This option removes 
conflicting objects from the project in the file where you right-clicked. 

• Remove conflicting objects from other files from output": This option removes 
from the project the conflicting objects present in the file which is in conflict 
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with the one you right-clicked on.. 

 
.   

By using these options, you can manage conflicting objects and remove them from 
the project in order to avoid any visualisation problems in HoloLens. Make sure you 
take the appropriate action based on your specific needs and the impact it could 
have on your project. 
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F. Data exchange 
Data generated by NEXT-BIM can be exported in the following formats: BCF (BIM 
Collaboration Format) and XLSX (Excel file format). 

If you wish to work collaboratively and share the data generated, it is recommended 
that you use BIM management platforms such as BIM Collab, BIM Track, AxeoBIM, 
Revizto, Kairnial and others. These platforms allow you to assign user rights to the 
various people involved and share information efficiently. 

In these platforms, you can use the viewer functionality to access specific positions 
in the BCF files produced by NEXT-BIM. In addition, some platforms offer integrated 
plugins for software such as Revit, facilitating the process of coordination and model 
verification. 

By using these BIM management platforms, you can collaborate more effectively, 
share the data produced by NEXT-BIM and carry out rapid model recollections. Make 
sure you choose the platform that best suits your needs and project requirements. 

The data generated by NEXT-BIM can be exported in the following formats: BCF 
(BIM Collaboration Format) and XLSX (Excel file format). 

If you wish to work collaboratively and share the data generated, it is recommended 
that you use BIM management platforms such as BIM Collab, BIM Track, AxeoBIM, 
Revizto, Kairnial and others. These platforms allow you to assign user rights to the 
various people involved and share information efficiently. 

In these platforms, you can use the viewer functionality to access specific positions 
in the BCF files produced by NEXT-BIM. In addition, some platforms offer integrated 
plugins for software such as Revit, facilitating the process of coordination and model 
verification. 

By using these BIM management platforms, you can collaborate more effectively, 
share the data produced by NEXT-BIM and carry out rapid model recollections. Make 
sure you choose the platform that best suits your needs and project requirements. 

 

Some users use the results of checklists or annotations generated by NEXT-BIM to 
make visual changes to their model. For example, they can assign different colours to 
elements depending on their status or validation status. 

This approach makes it possible to quickly visualise the status of different elements 
in the model and identify areas requiring particular attention. For example, non-
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compliant elements can be coloured red, while validated elements can be coloured 
green. 

This visual method makes it easier to identify problems and helps decision-making 
when coordinating and checking models. It also makes it easier to communicate 
status and annotation information to the project team. 

However, it is important to note that colouring the model according to the results of 
checklists or annotations is a functionality that depends on the platform or software 
used to view the model. You should check whether your platform or software 
supports this functionality or whether there are specific extensions or plugins for 
this. 

Performing this manipulation with a Dynamo script is a common and powerful 
approach. Dynamo is a visual programming environment built into Revit that allows 
users to create custom workflows and automate repetitive tasks. 

To colour the model according to the results of checklists or annotations using 
Dynamo, here are the general steps: 

 

 

 

1) Retrieve data from checklists or annotations: Using the appropriate Dynamo 
nodes, you can extract the relevant information from the checklists or annotations 
generated by NEXT-BIM. This can include statuses, values, comments, etc. 

2) Identify elements to be coloured: Using the extracted information, you can 
determine which elements in the model should be coloured based on their attributes 
or properties. For example, you can search for all non-compliant walls or all validated 
equipment. 

3) Apply colouring: Use the appropriate Dynamo nodes to assign colours to the 
identified elements. This can be done by modifying the graphical properties of the 
elements, such as the colour of the material or the colour of the line. 

4) Run the script: Once you have set up the Dynamo script, you can run it to apply 
the colouring changes to the model. 

It is important to note that setting up such a Dynamo script may require an in-depth 
knowledge of Dynamo, the structure of the data generated by NEXT-BIM and the 
properties of the model elements. It may be helpful to search for online resources, 
examples of similar Dynamo scripts or to seek the help of a Dynamo expert to guide 
you through this process. 
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Remember to test the script carefully on a backup copy of your model before 
applying it to the working model to prevent any unwanted or damaging changes. 
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